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Refer to the exhibit. A company is using Microsoft Teams with Cisco Unified Border Element integration, but the
administrator sees a one-way audio issue with Microsoft Teams. The administrator must modify the SIP profile to send
the proper information on the SDP for IP address for media to match the internal and external interface. Which set of
commands resolves the issue?

A. voice class sip-profiles 1 request INVITE sdp-header Connection-Info modify “2\.76\.1” “2.78.1"

B. voice class sip-profiles 1 request INVITE sdp-header Session-Owner modify “27\.0\.0” “27.3.0”

C. voice class sip-profiles 1 request INVITE sdp-header Connection add “2\.76\.1" “2.78.1"

D. voice class sip-profiles 1 request INVITE sdp-header Audio-Attribute modify “2\.76\.1" “2.71.1"

Correct Answer: C

QUESTION 2

Which section under the Real-Time Monitoring Tool allows for reviewing the call flow and signaling for a SIP call in real
time?

A. Analysis Manager > Inventory > Trace File Repositories
B. System > Tools > Trace and Log Central
C. Voice/Video > Session Trace Log View > Real Time Data

D. Voice/Video > Session Trace Log View > Open From Local Disk
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Correct Answer: C

Reference: https://www.cisco.com/c/en/us/support/docs/unified-communications/unified-communications-manager-
callmanager/213583-procedure-to-analyse-call-flow-of-sip-ca.html

QUESTION 3

Management wants to change the initial announcements for one of the existing call hunt groups. A new set of
announcement audio file was provided. Which two configuration steps must the administrator take to accomplish this
change? (Choose two.)

A. Identify the MOH audio source ID associated to one of the line group member\\'s “Network Hold MOH Audio
Source”.

B. Identify the MOH audio source ID associated to “Network Hold Source and Announcements” under the Queuing
section of the hunt pilot.

C. Identify the configured announcement names to change under the MOH audio source section, then upload the new
files to the respective announcements under the Announcement section.

D. Identify the MOH audio source ID associated to one of the line group member\\'s “User Hold MOH Audio Source”.

E. Identify the configured announcement names to change under the Announcement section, and assign the uploaded
files to the Queueing section of the hunt pilot.

Correct Answer: DE

QUESTION 4

Phone A calls to phone B, but phone B has Call Forward All set to a PSTN number. The route list responsible for the
phone B call to the PSTN has a standard local route group configured. Which route group must be used to send the call
to the PSTN?

A. route group defined in Standard Local Route Group section of Cisco UCM service parameters

B. route group from the phone B device pool

C. route group from the phone A device pool

D. standard local route group defined in the route group configuration

Correct Answer: C

QUESTION 5

Which elements does Cisco cloud mobility for collaboration include?
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A. Cisco Webex Collaboration Cloud Services

B. Cisco Collaboration Cloud

C. Cisco Collaboration Cloud and Cisco Webex Collaboration Cloud Services

D. Cisco Collaboration Cloud and Cisco Mobile and Remote Access Collaboration Cloud Services

Correct Answer: D

QUESTION 6

A solution for a large company is being reconfigured to optimize for cost saving. The company has an extensive global
QoS-enabled network with enough bandwidth to create a converged network. Local calls are relatively inexpensive in

countries the company have operations, but long distance and international calls are expensive.

Which type of configuration supported by Cisco UCM would help optimize cost control for this company?
A. standard local route groups for mobile users

B. Mobile and Remote Access

C. high complex codec support like G.729 to minimize bandwidth usage

D. tail end hop off

Correct Answer: D

QUESTION 7

A customer reports audio quality issues between video endpoints in the HQ location in California and one of the
branches in Texas. Which two actions must RTCP take to troubleshoot this issue? (Choose two.)

A. Allow for VAD to be used for calls using the G7.29 codec, which reduces the usage of the WAN bandwidth and saves
around 30% of bandwidth per call

B. Configure the rtcp keepalive command in Cisco Unified Border Element to generate reports, which can be reviewed
using the debug voip rtcp packet command.

C. Encrypt the media to stop rogue devices from replying and putting that traffic back on the WAN, which avoids any
extra bandwidth and ensures the quality of the calls.

D. Gather statistics on a media connection and information such as packets sent, lost packets, jitter, feedback, and
round-trip delay. This information can help isolate the type of audio quality issues and the direction of the affected
traffic.

E. Compress the headers of RTP traffic to lower the bandwidth consumption over the WAN, which allows more calls
with less bandwidth consumed.
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Correct Answer: BD

QUESTION 8

How does an engineer globalize routing for ingress calls coming from the PSTN to internal DNs?

A. At the PSTN gateway, put the calling number in PSTN format and the called number in DN format.

B. At Cisco Unified CM, put the calling number in E.164 format and the called number in PSTN format.

C. At the PSTN gateway, put the calling number in E.164 format and the called number in localized (DN) format.

D. At Cisco Unified Communications Manager, put the calling number in E.164 format and the called number in E.164
format.

Correct Answer: D

QUESTION 9

An administrator is configuring Cisco UCM and the system to send *.webex.com traffic to a Cisco UCM Session
Management Edition cluster. The administrator wants to limit which endpoints can reach *.webex.com. Which two items
must the administrator configure for the SIP route pattern? (Choose two.)

A. calling party transformation

B. partition of the SIP route pattern

C. connected party transformation

D. called party URI transformation

E. destination SIP trunk of the SIP route pattern

Correct Answer: BE

QUESTION 10

When configuring hunt groups, where does the administrator add the individual directory numbers that should be part of
the group?

A. route group
B. line group

C. hunt list
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D. hunt pilot
Correct Answer: B

Reference: https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cucm/admin/12_0_1/systemConfig/cucm_b_system-
configuration-guide-1201/cucm_b_system-configuration-guide-1201_chapter_010101.html

QUESTION 11

Refer to the exhibit.

Phone 1 Unified CM SBC (CUBE)
m P |
ha i il
INVITE (WIOFFER) INVITE(no SDP) INVITE WIOFFER
183 Session Progress (WIOFFER) 183 Session Progress (W/ANSWER)
27?7? (WANSWER) 1 >
& 2?27 (WANSWER)

v

A user reports that when they call a specific phone number, no one answers the call, but when they call from a mobile
phone, the call is answered. The engineer troubleshooting the issue is expecting the far-end gateway to cut through
audio on the 183 Session Progress SIP message. Which SIP Profile configuration element is necessary for the Cisco
Unified Communications Manager to send acknowledgement of provisional responses?

A. Allow Passthrough of Configured Line Device Caller Information must be enabled.

B. Accept Audio Codec Preferences in Received Offer must be set to On.

C. On the SIP Profile, the configuration parameter SIP Rel1XX Options must be set to Send PRACK for all 1xx
Messages.

D. Early Offer for G Clear Calls must be enabled.

Correct Answer: C

QUESTION 12
Users are reporting that several inter-site calls are failing, and the message "not enough bandwidth" is showing on the

display. Voice traffic between locations goes through corporate WAN, and Call Admission Control is enabled to limit the
number of calls between sites. How is the issue solved without increasing bandwidth utilization on the WAN links?
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A. Disable Call Admission Control and let the calls use the amount of bandwidth they require.
B. Configure AAR to reroute calls that are denied by Call Admission Control through the PSTN.
C. Reroute all calls through the PSTN and avoid using WAN.

D. Configure Call Queuing so that the user waits until there is bandwidth available.

Correct Answer: B

QUESTION 13

Refer to the exhibit.

Building A Building B
Results Summary Results Summary
Calling Party Infformation Calling Party Information
#Dialed Digits = 9195552388 #Dialed Digits = 9195552388
eMatch Result = RouteThisPattern #Match Result = RouteThisPattern
Matched Pattern Information Matched Pattern Information
@Called Party Number = 9195552388 ®Called Party Number = 9195552388
&Time Zone = Etc/GMT @Time Zone = Etc/GMT
®End Device = PSTN_RL ®End Device = PSTN_RL
@ Call Classification = OffNet @ Call Classification = OffNat
e|nterDigit Timeout = NO e|nterDigit Timeout = NO
@ Cevice Overrride = Disabled @ Device Overrride = Disabled
@ Qutside Dial Tore = NO @ Outside Dial Tone = NO
Call Flow Call Flow
Route Pattern: Pattern = [2—9]XX[2—9]XXXXKX Route Pattern: Pattern = [2—-9XX[2—9X XK
Route List Route List Name = PSTN_RL Route List Route List Name = PSTN_RL
RouteGroup:RouteGroupName = Standard Local Route Group (RTP_trunks) RouteGroup:RouteGroupName = Standard Local Route Group|
®PreTransform Calling Party Number = 2304 ® PreTransform Calling Party Number = 2305
@ PreTransform Called Party Number = 9195552388 @ PreTransform Called Party Number = 9195555388
Calling Party Transformations Calling Party Transformations
Called Party Transformations Called Party Transformations
Device ‘Type = SIPTrunk

A standard local route group is configured for long-distance calls. Calls from building A succeed, but calls from building
B fail. On the system, each building has its own device pool. The DNA tool is used to test the configuration. How is this
issue resolved?

A. Change the partition of the route pattern.

B. Add a sip trunk inside route group Standard Local Route Group.

C. Modify the route pattern to add a prefix of 91.

D. Add a local route group on the device pool configuration.

Correct Answer: B

QUESTION 14
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Sent:

INVITE 51p:90119199993214538cisco.con: 5068 SIP/2.0

Vaa: SIP/2.0/U0P 192.168.1.04: 5880 brancherSnCAbEFE4ST 15AD
Agsate-Party-10: "User A" «sjp:dddd@cisco.coms=;party=callang;screen=no;privacy=off
From; “User A" <gip;dddagcisco.coms; tag=E141986A-D65

To: =31p:98119199993214538c15¢co. Com>

Date: Thu, 31 Jan 2019 19:34:47 MY

Call-ID: JANEC1I26-24C611E9-81080@31-06010C0BSc i3co.con
Supported: l18@8rel,timer,retource-priority, replaces,sdp-anat
Min-SE: 18680

Cisco-Cuid: 1127492352-0000065536-0008014911-02039510114
User-Agent: Cisco-S5IPGateway/105-15.4.3.57

Allew: INVITE, OPTIONS, BYE, CANCEL, ACK, PRACK, UPDATE, REFER, SUBSCRIBE, NOTIFY, INFO, REGISTER
CSeq: 181 TINVITE

Timestanmp: 1548963287

Contact: =<si1p:442842192.168.1.14:586@8>

Expires: 180

| Allow-Events: Telephone-event

Max-Forwards: 69

Session-Expires: lape

Centent-Type: application/adp

Coantent-Disposition: sesslon;handling=required
Content-Length: E&68

w=8

e=CiscoSystemsCOM-SIP 113060473 1 IN IP4 192.168.1.18
1=5IP Call

c=lN IP4 192.168.1.14

b=TIAS: 384288

B=AS: 104

=8 @

eraudio 24500 RTP/AVP 9 @ 4 116 18 101

—Output oem)ted

BR7080: Jan 31 19:34:47.248: J/1855739/403400880000/51P/MagicesipDisplayMag:
Received:

SIP/2.8 483 From: UR] not recognizen

Via: SIP/2.0/U0P 192.168.1.14:5860;branch=z9hG4bEFE4ST15AD

From: “User A" «<gip:d444agl92.168.2.1>;tageEl41988A-063

To: =3ilp:90110199993214538c izco.com»;

Call-1D: JAREC126-24C611E9-A1DBDAI1-BED1ACOBRc isco. con
CSeq: 101 INMVITE

Timestamp: 154963287

Server: Provider/2.9

Content-Length: @8

Refer to the exhibit. An administrator is trying to test outbound calls toward the ITSP but cannot complete the call and
receives a SIP error. ITSP is consulted, and the issue is that the ANI that is being sent is not the DID provided
8005532447. Which configuration change sends the correct ANI on the INVITE sent to ITSP to fix the error?

A. voice class sip-profiles 2 request INVITE sip-header To modify “sip:(.*)@” sip:8005532447@

B. voice translation-rule 3 rule 1/.*/ /8005532447/

C. voice class sip-profiles 1 request INVITE sip-header Diversion modify “sip:(.*)@” “sip:8005532447@"

D. voice translation-rule 4 rule 1/~.*\(8005532447\)/ \1/

Correct Answer: B

QUESTION 15
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02904115.001 |09.08:07.093 |Appinfo |SIPTcp - wait_SdiSPISignal; Outgoing SIP TCP message to 10.1.1.102 on
port 50244 index 22157

[166156 NET]

ACK 5ip:1315932e-f129-4203-2323-2f940216638e®10.1.1.102:50244 transport=tcp SIP/2.0

Via: SIP/2.0/TCP 10.1.1 5:5060,branch=29hG4bKb4fa1faBod7e

From: <sip:1001©®10.1.1.5>;tag=93016~bb788fb3-a1ef-4d03-296d-651038e22050-28377951

To: <sip:1000@cucm1251 cisco. lab>tag=7001b5dab46425b45ec6648a-25dcafal

Date: Wed, 28 Jul 2021 13:08:07 GMT

Cali-ID: cee27300-1ed10da7-b403-3251300¢@10.1.1.5

User-Agent: Cisco-CUCM12.5

Max-Forwards: 70

CSeq: 103 ACH

Allow-Events: presence

Session-1D: 36ed016300105000a000283422824611;remote=49f3b76a00105000a0007001b5daba64
Content-Type: application/sdp

Content-Length: 412

v=0
o=CiscoSystemsCCM-5IP 93016 3 IN IP4 10.1.1.5
s=SIP Call

c=IN IP410.1.15

t=00

m=audio 4000 RTP/AVP O
a=X-cisco-media:umoh
b=TIAS 64000
a=ptime:20

a=rtpmap.0 PCMU /8000
asinactive

Refer to the exhibit. This message is sent to the device being placed on hold for the Music On Hold audio setup. The
held party reports receiving dead air rather than music when the call was put on hold. The software Music On Hold
server on Cisco UCM is used in this scenario. Assume that the audio leg between the Music On Hold server and the
held device uses G.711, and the relevant region relationship is configured for 64 kbps. What is the cause of the issue?
A. The bandwidth configured for this region relationship is too low and must be increased to 96 kbps or higher.

B. The device that is placed on hold does not support G.711, and a transcoder could not be allocated for the call.

C. Cisco UCM is sending a=inactive to the held device.

D. The Music On Hold server does not support G.711 and a transcoder could not be allocated for the call.

Correct Answer: C
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